
 ETABS*های بتنی در نکات طراحی سازه*

 :ساسُ هصالح هطخصات

 

 

 

 

     E=15100√fc =15100*√210=2.0E+5  kg/cm
2
 =2.0E+9 kg/m

2 

 : (Aj)پیچطی تشرگٌوائی ضزیة کٌتزل

 آیذ:تذعت هی  AJرا اًتخاب ًوَدُ ٍ عپظ تا هزاخؼِ تِ لغوت سیز همذار ضزیة  x  ٍyاتتذا دٍ ًمغِ اًتْایی عاختواى در خْت 

Display > Show Tables… > Analysis Results > Point Displacements 

  

 

 

 



 UBC97آییي ًاهِ               افشار: ًزم در ضلاقی ًیزٍي اػوال ًحَُ

 ًاهِآیيي ایي اس سلشلِ خاًثی ًيزٍي تؼزیف خْت گيزد،هی درًظز 0822اعتاًذارد هؾاتِ را ؽلالی ًيزٍي UBC97 ایٌىِ تِ تَخِ تا

 :وٌينهی اعتفادُ

 : Edit/Reference Plan هٌَي

 تزاس تا هتماعغ ّايالواى وليِ  Etabsافشار  ًزمؽَد. )هی اعتفادُ گشیٌِ ایي اس ارتفاع در دلخَاُ تزاس ّز یا عثمًِين تؼزیف هٌظَر تِ

 (گزددهی هحاعثاتی ًتایح در خغا آهذى ٍخَد تِ تاػث وِ ؽىٌذهی را عثمات

 

 

 

 

 

 

 

 

  

 تایغتهی فَق گشیٌِ اس اعتفادُ تصَر در

 گشیٌِ تيه Mass Source هٌَي در

Lump Lateral mass at st  ِتزداؽت

 ؽَد.



  :دیافزاگن اس خارج ّايگزُ خذاساسي

 هَرد در .گزدد خذا عمف اس تایغتهی صَرت ایي غيز ٍ در هتصل عمف تِ تایذ تاؽذ تواط در عمف تا یه ًمغِ در وِ ايگزُ ّز

 اعت. دیافزاگن تِ هتصل تاؽذ داخل آى تِ هتصل عتَى پاي صَرتيىِ در تادتٌذ تا تيز هحل تماعغ گزُ هحَر اس خارج ّايتٌذ تاد

 گزدًذ.هی خذا دیافزاگن عپظ اس ٍ اًتخاب ًظز هَرد ًماط هٌظَر ایي تزاي

 .گزدد خذا دیافزاگن اس تایغتیهی ًيش عثمِ ًين تزاس تيزّاي ٍ ّاعتَى ٍعظ در دعتىْا تِ هزتَط ًماط

 

 

 

 

 

 

 

 :ٍاصگًَی لٌگز کٌتزل

    Display/Show Tables/Building Output/ Select Combo Ex or Eyعثمات:         خزم هزوش ٍ خزم ًوایؼ-1

 ؽَد:هی دادُ ًوایؼ عختی هزوش ٍ خزم هزوش خزم هؾخصات Center Mass Rigidity وؾَي اًتخاب تا

  

 

 گزُ خارج دیافزاگن

 گزُ داخل دیافزاگن

 w=152516.4870*9.81=1496186.74 kg ٍسى کل ساسُ

 x Mx=1496186.74*Min[6.538, L-6.538](لٌگز هقاٍم

 y My=1496186.74*Min[5.449, B-5.449](لٌگز هقاٍم

L تؼذ ساسُ در خْت=Y 

B تؼذ ساسُ در خْت=X 



 Display/Show Tables/Building Output/ Select Combo Ex or Ey:   ٍاصگًَی لٌگز ٍ پایِ تزػ ًوایؼ-2

 :ؽَدهی دادُ ًوایؼ ٍاصگًَی لٌگز ٍ پایِ تزػ Story Shears وؾَي اًتخاب تا

 

 

 

 تزرسی هٌظوی یا ًاهٌظوی ساسُ:

عاسي تزػ دیٌاهيىی ٍ اعتاتيىی تَدى عاسُ در ّوپایِؽَد، داًغتي هٌظن یا ًاهٌظن ّایی وِ اس تحليل عيفی اعتفادُ هیدر پزٍصُ

گيزد. یىی اس تٌذّا وٌتزل فاصلِ تيي هزوش خزم ٍ هزوش عختی اًدام هی 6هْن اعت. هٌظن ٍ یا ًاهٌظن تَدى عاسُ عثك هثحث 

 درصذ تؼذ عاسُ در آى خْت تاؽذ: 02تاؽذ وِ تایذ ووتز اس عاسُ هی

 y My=196399.044+118158.39*H(لٌگز ٍاصگًَی

 x Mx=2221047.634+137602.18*H(لٌگز ٍاصگًَی

Hُضخاهت پی ساس= 

 XCM-XCR|=|5.449-6.985|=1.536  <  0.2*10=2      OK|            طثقِ ّوکف:هثال

هتز است. 10فزض تؼذ ساختواى تزاتز   



 :تتي پَضص ّا،هیلگزد فاصلِ ّايهحذٍدیت

 ضخاهتوٌتزل ؽَد ٍ  9ّا( عثك هثحث تزاي اػضاي خوؾی )تيزّا( ٍ اػضاي فؾاري )عتَى هَاسي هيلگزد دٍ ّز تيي آساد فاصلِ

 :تاؽذ ووتز سیز همادیز اس یه ّيچ اس ًثایذ ّاهيلگزد رٍي تتي پَؽؼ

 سیز: خذٍل اعاط تز هحيغی ؽزایظ تا هتٌاعة ج(    تتي عٌگذاًِ تشرگتزیي اعوی لغز عَم چْار ب(     هيلگزد لغز الف(

 

 ،ّغتٌذ یىپارچِ خَد ّايگاُتىيِ تا وِ ّائیػضَ تزاي هَثز دّاًِ عَل عاختواى هلی همزرات 9 هثحث اس 0-8-02-9هغاتك تٌذ 

 آساد عَل تزاتز واهل گيزداري تا عزُ اػضاي تزاي هَثز دّاًِ َلؽَد. ع گزفتِ ًظز در ّاگاُ تىيِ هحَر تا هحَر فاصلِ هؼادل تایذ

 تاؽذ.هی آى

 .گزفت ًظز تتٌی در ّايعاسُ در را (End Offset)صلة  عَل ، ًثایذ9 هثحث تٌذ اعاط ایي تز ایي تٌاتز

 

 خَردگی: تزك ضزایة اػوال

خَردگی عختی خوؾی عتًَْا در ّز ضزائة تزن" تغييز هىاى خاًثی ًغثی ٍالؼی عزح "تزاي تحليل، عزاحی عاسُ ٍ وٌتزل -0

خَردگی عختی پيچؾی عثك ضَاتظ ّوچٌيي تزاي تيزّا ضزیة تزندر ًظز گزفتِ ؽَد.  0..2ٍ تزاي تيزّا  2.0دٍ خْت تزاتز 

 در ًظز گزفتِ ؽَد. 2.00تفغيز آیيي ًاهِ تتي ایزاى تزاتز 

خَردگی عختی خوؾی عتًَْا در ّز دٍ س آى( ضزائة تزنتزاي هحاعثِ سهاى تٌاٍب تحليلی عاسُ )در صَرت ًياس تِ اعتفادُ ا-0

تَخِ ؽَد وِ در صَرت اعتفادُ اس سهاى تٌاٍب تحليلی در وٌتزل تغييز ؽىل،  در ًظز گزفتِ ؽَد. 2.0ٍ تزاي تيزّا  0خْت تزاتز 



هحذٍد گزدد. )حتی  2.20تِ  ثاًيِ تاؽذ، همذار هداس تغييز ؽىل خاًثی ًغثی عزح 2.0اگز همذار سهاى تٌاٍب تحليلی عاسُ تيؼ اس 

 ثاًيِ تاؽذ( 2.0اگز سهاى تٌاٍب تدزتی عاسُ ووتز اس 

خَردگی عختی خوؾی تزداري، ضزائة تزنتحت اثز سلشلِ عغح تْزُ" تزداريتغييز هىاى خاًثی ًغثی تْزُ" تزاي هحاعثِ -.

 در ًظز گزفتِ ؽَد. 2.0ٍ تزاي تيزّا  0عتًَْا در ّز دٍ خْت تزاتز 

 UBC94آییي ًاهِ           افشار: ًزم در ضلاقی ًیزٍي اػوال ًحَُ

 یىغاى ؽَد: 0822ًاهِ ضزیة تاستاب تا ضزیة تاستاب آیييوافی اعت  UBC94ًاهِ در آیيي

   

  
 = 

   

 
    (R=RW   ,   I=I   ,  Z=A    ,  C=B) 

C=1.25 
 

 
 
 

 = 2.5 
  

 
  

 

                     S= 2(TS  
 

  

اهىاى هؼزفی همذار اػؾاري ٍخَد ًذارد، همذار آى را  Site Coefficientدر خؼثِ ٍیزایؼ  ETABSتا تَخِ تا ایٌىِ در ًزم افشار 

ؽَد. ایي هؼادل عاسي تِ ؽزعی صحيح اعت وِ وٌين وِ تا تَخِ تِ خغی تَدى راتغِ هؾىلی ایداد ًویتا ضزیة اّويت ػَض هی

 اعتفادُ ًوائين. UBC97ًاهِ ؽَد. اگز ًؾذ تایذ اس آیيي 0.0ووتز اس  Bضزیة 

 اصلاح ٍسى تیزّا:

رعذ  تایذ واّؼ دادُ تيزّا هیٍسى لغوتی اس عمف وِ تِ هزوش  اس آًدایی وِ ًثایذ ٍسى عمف تا هزوش تيزّا در ًظز گزفتِ ؽَد،

 آیذ:. ضزیة واّؼ ٍسى تيزّا اس راتغِ سیز تذعت هیؽَد

 

 -R= 1 ضزیة واّؼ
 

   
                                                                          R= 1- 

 

    
 

 

 ؽَد:تؼزیف هی MASSلت تار اتِ ح اختلاف تيي تار ٍ خزم دیَار خاًثیٍ  تيي تار ٍ خزم پارتيؾياختلاف  :MASSتار 

اختلاف تار ٍ خزم  

  (D-C)پارتيؾي

 خزم پارتيؾي

(D) 
 تار پارتيؾي

(C) 
اختلاف تار ٍ خزم 

 (B-A)دیَار خاًثی

 خزم دیَار خاًثی

(B) 
 تار دیَار خاًثی

(A) 

kg/m
2 

kg/m
2 

kg/m
2 

kg/m kg/m kg/m 

D-C (C1+C2)/2 C1 B-A (A1+A2)/2 A1 

D-C (C2+C3)/2 C2 B-A (A2+A3)/2 A2 

D-C (C3+C4)/2 C3 B-A (A3+A4)/2 A3 

D-C (C4+C5)/2 C4 B-A (A4+A5)/2 A4 

-------- -------- C5 -------- -------- A5 

 kg/m3 250)ٍسى ٍاحذ تيزچِ ٍ دال( تزاتز  qهؼوَلاً 

 ٍγ  2500ٍسى ٍاحذ حدن تتي تزاتز kg/m3 تاؽذهی 

PARKIN

STI 

ST2 

ROOF 

BASE 



 ACI 318-99آییي ًاهِ                                       :      استاتیکی تزکیثات تارگذاري

0.9DL+1.43(± EXP±0.3EY) 16 1.4DL 1 

0.9DL+1.43(± EYP±0.3EX) 17 1.4DL+1.7LL 2 

0.9DL+1.43(± EYN±0.3EX) 18 0.75(1.4DL+1.7LL±1.875 EXN) 3 

0.75(1.4DL+1.7LL+1.875(± EXP±0.3EY±0.3EZ)) 19 0.75(1.4DL+1.7LL±1.875 EXP) 4 

0.75(1.4DL+1.7LL+1.875(± EXN±0.3EY±0.3EZ)) 20 0.75(1.4DL+1.7LL±1.875 EYP) 5 

0.75(1.4DL+1.7LL+1.875(± EYP±0.3EX±0.3EZ)) 21 0.75(1.4DL+1.7LL±1.875 EYN) 6 

0.75(1.4DL+1.7LL+1.875(± EYN±0.3EX±0.3EZ)) 22 0.9DL±1.43 EXN 7 

0.75(1.4DL+1.7LL+1.875(+ EZ±0.3EX±0.3EY)) 23 0.9DL±1.43 EXP 8 

0.75(1.4DL+1.7LL+1.875(- EZ±0.3EX±0.3EY)) 24 0.9DL± 1.43EYP 9 

0.9DL+1.43(± EXP±0.3EY±0.3EZ) 25 0.9DL±1.43 EYN 10 

0.9DL+1.43(± EXN±0.3EY±0.3EZ) 26 0.75(1.4DL+1.7LL+1.875(±EXN±0.3EY)) 11 

0.9DL+1.43(± EYP±0.3EX±0.3EZ) 27 0.75(1.4DL+1.7LL+1.875(±EXP±0.3EY)) 12 

0.9DL+1.43(± EYN±0.3EX±0.3EZ) 28 0.75(1.4DL+1.7LL+1.875(±EYP±0.3EX)) 13 

0.9DL+1.43(+ EZ±0.3EX±0.3EY) 29 0.75(1.4DL+1.7LL+1.875(±EYN±0.3EX)) 14 

0.9DL+1.43(- EZ±0.3EX±0.3EY) 30 0.9DL+1.43(± EXN±0.3EY) 15 

 

 

 

 ACI 318-05اساط آییي ًاهِ  تارگذاري تز



 

 

 



 

 : ETABSتزسین هٌحٌی در 

افشار تذعت آٍردُ ٍ عپظ هختصات ًماط تذعت آهذُ تِ ًزم Auto cadافشار ًماط )هختصات( رٍي هٌحٌی هَرد ًظز را اس ًزم-0

Excel گزدد ٍ ایي ًماط اًتمال یافتِ ٍ خذٍلی هغاتك ؽىل سیز آهادُ هیCopy ؽَد.گزفتِ هی 

ًوائين. اگز ًماط لاتل هؾاّذُ هختصات هثذا را ٍارد هی Pasteعثمِ هَرد ًظز را فؼال وزدُ ٍ تا اخزاي فزهاى  Etabsدر تزًاهِ -0

تَاى تَعظ الواًْاي . ایي ًماط را هیغيز فؼال ؽَد Set Building View Optionsاس هغيز  Invisibleًثاؽٌذ تایذ گشیٌِ 

 خغی تِ یىذیگز هتصل ًوَد ٍ هٌحٌی را ایداد ًوَد.

 

 

 

 

 

 

 

  

 

 

 

 

هختصات ًماط رٍي هٌحٌی در 

Auto Cad 

 Excelهختصات ًماط در ًزم افشار 



 :تار آساًسَر

عثك تَصيِ هثحث ؽؾن، در هحاعثِ تار ؽَد. اعزاف آى در عثمِ تام ٍارد هیّاي تار آعاًغَر تِ صَرت چْار تار هتوزوش تِ عتَى

ؽَد. یؼٌی وليِ تارّاي ٍاردُ تِ آعاًغَر اػن اس هزدُ ٍ سًذُ دٍ تزاتز در ًظز گزفتِ اػوال هی 0هزدُ ٍ سًذُ آعاًغَر، ضزیة افشایؼ 

ؽَد. تار سًذُ ٍ اتؼاد ويلَگزم در ًظز گزفتِ هی 0022تا  0222تار هزدُ آعاًغَر تغتگی تِ ظزفيت آى دارد ٍ هؼوَلا تيي ؽَد. هی

 تاؽذ:چاُ آعاًغَر تز اعاط هثحث پاًشدّن همزرات هلی عاختواى تِ ؽزح سیز هی

 

 تؼییي اتؼاد ستَى:

تِ ًشدیىتزیي ٍ س راتغِ تمزیثی سیز اعتفادُ ًوَد. اًذاسُ تذعت آهذُ لاسم اعت تَاى اتزاي تخويي اتؼاد اٍليِ عتَى هزتؼی ؽىل هی

 گزد ؽَد: 02تشرگتزیي ضزیة 

 

 

                                                                                                        

 

 ّا:تطخیص اػضاي هَثز در کٌتزل دریفت ساسُ

تایذ هماعغ تشرگتزي تزاي تزخی اس اػضاي عاسُ در ًظز گزفتِ  اگز ٌّگام وٌتزل دریفت، همادیز دریفت اس حذ هداس تداٍس وزدُ تاؽذ

 هَثز اػضاي تؾخيصؽَد تا تغييز هىاى عاسُ واّؼ یاتذ. تزاي تؾخيص ایٌىِ وذام اػضاء تاثيز تيؾتزي در وٌتزل دریفت دارًذ )

ٍ  Displayایي هٌظَر در تزًاهِ اس هٌَي  تزايتَاى اس ًوَدارّاي اًزصي/وار در تزًاهِ اعتفادُ وزد. ( هیتغييز هىاى عاسُ وٌتزل در

 تز هَثز اػضايّایی وِ داراي اًزصي تيؾتزي ّغتٌذ، اعتفادُ وزد ٍ الواى .…Show Energy > Virtual Diagramاس گشیٌِ 

 ؽَد.تزي حفظ هیتَدُ تِ ًحَي وِ تا تمَیت آى اػضاء، التصاد عاسُ ًيش تِ ًحَ هغلَب تغييز هىاى عاسُ

 



 ACI 318-99آییي ًاهِ                                       تزکیثات تارگذاري دیٌاهیکی:       

 تِ را دیٌاهيىی عيف چْار هزحلِ چْار Define/Response Spectrum Cases لغوت درتزاي تؼزیف تارّاي دیٌاهيىی 

 ٍ( اٍل تاي دٍ تزاي) اتفالی هزوشیت اس تزٍى درصذ 0 گزفتي ًظز در تاSPECX ،SPECY، SPECX2 ٍ  SPECY2 ًاهْاي

 :وٌينهی هؼزفی درصذ 0 هيزایی ٍ( دٍم دٍتاي تزاي) اتفالی هزوشیت اس تزٍى گزفتي ًظز در تذٍى

0.9DL+1.43(SPECY +0.3SPECX2) 02 1.4DL 1 

0.75(1.4DL+1.7LL+1.875 SPECX +0.3SPECY2±0.3EZ)) 00 1.4DL+1.7LL 2 

0.75(1.4DL+1.7LL+1.875 SPECY +0.3SPECX2±0.3EZ)) 00 0.75(1.4DL+1.7LL+1.875 SPECX) 3 

0.75(1.4DL+1.7LL+1.875(+ EZ+0.3 SPECX2 +0.3SPECY2)) 0. 0.75(1.4DL+1.7LL+1.875 SPECY) 4 

0.75(1.4DL+1.7LL+1.875(- EZ+0.3 SPECX2 +0.3SPECY2)) 01 0.9DL+1.43 SPECX 5 

0.9DL+1.43(SPECX +0.3SPECY2±0.3EZ)) 00 0.9DL+1.43 SPECY 6 

0.9DL+1.43(SPECY +0.3SPECX2±0.3EZ) 06 0.75(1.4DL+1.7LL+1.875(SPECX +0.3SPECY2)) 7 

0.9DL+1.43(+ EZ+0.3 SPECX2 +0.3SPECY2) 00 0.75(1.4DL+1.7LL+1.875(SPECY +0.3SPECX2)) 8 

0.9DL+1.43(- EZ+0.3 SPECX2 +0.3SPECY2) 08 0.9DL+1.43(SPECX +0.3SPECY2) 9 

 

 دیٌاهیکی: طیفی تحلیلرٍش 

=Sa، ؽتاب عيفی تِ صَرت 6یا هثحث  0822هغاتك آیيي ًاهِ  تارگذاري عيفی:-1
 

 
 ABI تا تَخِ تِ ایٌىِ تٌْا  آیذ.تذعت هی

  g*اعت، ػثارت Bضزیة  Saلغوت هتغييز 
  

 
تِ  Bؽَد. ضزیة تاستاب اػوال هی Bتِ صَرت ضزیة همياط تِ عيف تاستاب   

 ؽَد:صَرت سیز هؼزفی هی

                

               B= 

 

 آیذ:را تذعت هی Bٍ رٍاتظ تالا همادیز  Tخذٍل سیز را تؾىيل دادُ ٍ تا تَخِ تِ همادیز  Tًغثت تِ  Bتزاي تزعين هٌحٌی 

3 2.5 2 1.5 1.25 1 0.75 0.6 0.5 0.1 0.05 0.025 0 T 

             B 

 

عثمِ ٍ هؼزفی وزدى  nتزعذ. در یه پزٍصُ  92*هغاتك تا آیيي ًاهِ تایذ حذالل عِ هذ فؼال ؽًَذ. ّوچٌيي ضزیة خذب تایذ تِ %

هذ فؼال ؽذُ ٍ هغلواً ؽزایظ هَرد ًياس آیيي ًاهِ  3nدرخِ آسادي خزهی ٍخَد دارد. در ایي حالت ّز  3nدیافزاگن صلة، تؼذاد 

 در ًظز گزفتِ ؽَد. 2.20اعتفادُ ؽَد ٍ هيزایی عثك آیيي ًاهِ تزاتز  CQCتزآٍردُ خَاّذ ؽذ. تزاي خوغ آثار هذّا اس رٍػ 
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را اخزا وزدُ ٍ در خؼثِ ظاّز ؽذُ رٍي  Define > Response Spectrum Functionsدعتَر  هؼزفی عيف ضزیة تاستاب:-2

 وليه وٌيذ ٍ ًماط خذٍل را ٍارد وٌيذ: Add User Spectrumگشیٌِ 

 

 

 

 

 

 

 

 

 Add New Spectrumرا اخزا وزدُ ٍ رٍي دووِ  Define>Response Spectrum Casesدعتَر  ّاي تار عيفی:حالت-3

درصذ هيزایی، در  Dampingًام تار هَرد ًظز، در ًاحيِ   Spectrum Case Nameوليه وٌيذ. در خؼثِ ظاّز ؽذُ در لغوت 

همذار  scale factorٍ در خؼثِ  لثل لغوت در ؽذُ هؼزفی تاتغ Function، در لغوت Input response spectrumًاحيِ 

*g  
  

 
را تِ ػٌَاى  2.20ضزیة  Eccentricityرا ٍارد وٌيذ. ّوچٌيي تزاي تؼزیف تارّا تا خزٍج اس هزوشیت در خؼثِ ٍیزایؼ    

 خزٍج اس هزوشیت تصادفی ٍارد ًوائيذ:

 

 

 

 

 

 

 

 

 

 

تا در  yتار دیٌاهيىی در خْت هحَر 

 ًظز گزفتي تزٍى اس هزوشیت اتفالی

  g*همذار 
𝑨𝑰

𝑹
   

 تصادفی هزوشیت اس خزٍج

 هيزایی درصذ



 

را فؼال  Dynamic Analysisرا اخزا وزدُ ٍ گشیٌِ  Analyze > Set Analysis Optionsدعتَر  تٌظيوات تحليل عاسُ:-4

هذ را  3nتؼذاد  Number of Modesوليه وٌيذ. در خؼثِ ٍیزایؼ  Set Dynamic Parametersوٌيذ ٍ عپظ رٍي دووِ 

 وليه وٌيذ. OKٍارد وزدُ ٍ رٍي دووِ 

  عاسي تزػ پایِ دیٌاهيىی ٍ اعتاتيىی:یىغاى-5

 :تؼذ اس اًدام ػوليات تحليل عاسُ

در هَاردي وِ تزػ پایِ تذعت آهذُ اس رٍػ تحليل عيفی ووتز اس تزػ پایِ تحليل اعتاتيىی هؼادل تاؽذ، همذار تزػ پایِ -0

 ّاي عاسُ هتٌاعة تا آًْا اصلاح گزدد:سیز افشایؼ دادُ ؽذُ ٍ تاستابتحليل عيفی تایذ تِ همادیز 

 ُّا تایذ در ًغثت تزػ پایِ اعتاتيىی هؼادل تِ تزػ پایِ تِ دعت آهذُ اس تحليل عيفی ّاي ًاهٌظن، همادیز تاستابدر عاس

 ضزب ؽًَذ.

 ُتيىی هؼادل تِ تزػ پایِ تِ دعت آهذُ اس درصذ ًغثت تزػ پایِ اعتا 82ّا تایذ در ّاي هٌظن، همادیز تاستابدر عاس

 (.تاؽذ ووتز عيفی تحليل رٍػ اس آهذُ تذعت پایِ تزػ اس ًثایذ ؽذُ تؼذیل پایِ تزػ همادیز) تحليل عيفی ضزب ؽًَذ.

 پایِ تزػ همذار تاؽذ، هؼادل اعتاتيىی تحليل پایِ تزػ اس تيؾتز عيفی تحليل رٍػ اس آهذُ تذعت پایِ تزػ وِ هَاردي در-0

 تحليل عيفی واّؼ داد.ًغثت تزػ پایِ اعتاتيىی هؼادل تِ تزػ پایِ تَاى تِ را هیّاي عاسُ ٍ وليِ تاستاب عيفی تحليل

را فؼال وٌيذ ٍ در خؼثِ  Building Outputرا اخزا وزدُ ٍ در خؼثِ ظاّز ؽذُ گشیٌِ  Display > Show Tables*دعتَر 

اعلاػات هَرد ًياس ًوایؼ  OKٍ تا وليه رٍي دووِ  را اًتخاب وٌيذ EPX ،EPY ،SPECXI ٍ SPECY1اًتخاب تار، تارّاي 

 :تَاى همذار تزػ پایِ دیٌاهيىی ٍ اعتاتيىی را هؾاّذُ ًوَدؽَد ٍ هیدادُ هی



 

 اصلاح عيف تاستاب:-6

را  Modify/Show Spectrumرا اخزا وزدُ ٍ رٍي ّز یه اس تارّا، گشیٌِ  Define>Response Spectrum Casesدعتَر 

همذار ضزیة را در ًغثت  scale factorٍ در لغوت  Input response spectrumوليه وزدُ ٍ در خؼثِ ظاّز ؽذُ در ًاحيِ 

 وٌين.هی ضزب تذعت آهذُ اعت( 0)وِ در گام  عيفی تحليل اس آهذُ دعت تِ پایِ تزػ تِ هؼادل اعتاتيىی پایِ تزػ

 

 

 

 

 

 

 

 

 

 

 

 

 

 در حالت دیٌاهیکی: هختلط قاتْاي در درصذ 25 قاػذُ کٌتزل

 تزاتز  فایل ایي تَپظ اس ّن پایِ عاسي  scale factor ضزیة ٍ ؽذُ تي 100 اصلی فایل در دیٌاهيىی پایِ تزػ فزض مثال:

 وٌين تثذیل هین ٍ عختی دیَار تزؽی را تِ ػذد وَچىی وٌيهی درعت رٍ% 25 فایل فایل، ایي رٍي اس حالاتذعت آهذُ اعت.  0.5

 ٍلی ؽَد تي 25 دیٌاهيىی پایِ تزػ وِ نداری اًتظار. نوٌيهی ٍارد scale factor ضزیة ػٌَاى تِ 4/1*0.5=0.125 ػذد ٍ

 عختی ّزچِ یؼٌیدارد،  عاسُ عختی تا هغتمين ارتثاط پایِ تزػ همذار اعتاًذارد عزح عيف اس اعتفادُ تا دیٌاهيىی تحليل در چَى

 تي 25 پایِ تزػ تا نوٌي اصلاح رٍ scale factor تایذ .ؽَدتي هی 15تزاتز  پایِ تزػ ؽَد،هی ووتز پایِ تزػ تاؽِ ووتز عاسُ

 (scale factor =1.666*0.125) نوٌي ضزب 15/25=1.666 اصلاح ضزیة در رٍ scale factor تایذ هٌظَر یيؽَد ٍ تزاي ا

0.42* 
𝟏𝟑𝟕𝟔𝟎𝟐.𝟏𝟖

𝟏𝟒𝟎𝟐𝟐𝟕.𝟎𝟒
 = 0.412 

 تحليل رٍػ اس آهذُ تذعت پایِ تزػچَى در ایي هثال 

تذعت  هؼادل اعتاتيىی تحليل پایِ تزػ اس تيؾتز عيفی

 اعتاتيىی پایِ تزػ ًغثت تِ عاسُ تاستاب همذار آهذ،

 .دادُ ؽذ واّؼ عيفی تحليل پایِ تزػ تِ هؼادل



 

 :ضکل هستطیلی یا هزتغ( تالکي) تزاط تزسین

را  Draw Point Objectsگشیٌِ  Drawاس هٌَي  پظع وٌيذ فؼال را Similar Stories ٍ رفتِ عثمِ آخزیي پلاى تِ اتتذا

 هحل در دليماً ًمغِ تا وٌيذ وليههثذا هختصات  2.22 ًمغِ در دليماً آى اس پظ وٌيذ ٍارد دليك را ًماط هختصاتاًتخاب وزدُ ٍ 

 مثال: .ؽَداي تزعين هیّایی تيي ًماط، تالىي عزُدرج گزدد. در اًتْا تا تزعين الواى ؽذُ هؾخص

 

 

 

 

 

 دایزُ: قطاع یا ايدایزُ( تالکي) تزاط تزسین

 هٌَ اس اًتخاب اس پظ ٍ وٌيذ اًتخاب را ؽزٍع ًمغِ راعت عوت اس .وٌيذ اًتخاب را ؽزٍع ًمغِ تایغتهی اتتذا تزاط تزعين تزاي

Edit > Extrude Points Line…  در لغوتRotate About Point را ٍارد  وٌذوِ وواى را تزعين هی دایزُ هزوش هختصات

را  2ػذد  Total Dropتؼذاد لغاع هَرد ًظز تا ًمغِ اًتْا ٍ در وادر  Numberساٍیِ ّز لغاع ٍ در وادر  Angleًوائيذ. در وادر 

 مثال:ٍارد ًوائيذ. 
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1.2 m 

 1تالىي ؽوارُ 

 2تالىي ؽوارُ 

هثذا هختصات 

(0,0) 



   تزاي تزعين دٍ رٍػ ٍخَد دارد: :1تزعين تالىي ؽوارُ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 دایزُ هزوش هختصات

ًغثت تِ هثذا 

هختصات

ول تالىي را تِ صَرت یه لغاػی اس دایزُ تزعين ًوائين. اتتذا ًمغِ ؽزٍع -1

 در Edit>Extrude Points Line هٌَ اس ٍ )عوت راعت( را اًتخاب وزدُ

ّاي را تا تَخِ تِ اًذاسُ دایزُ هزوش هختصات Rotate About Point لغوت

 در. ًوائينٍارد هی (2,11.5)دادُ ؽذُ در پلاى ًغثت تِ هثذا هختصات تزاتز 

 تؼذاد Number وادر در ٍ 10.1285را تزاتز  لغاع ّز ساٍیِ Angle وادر

 را 0 ػذد Total Drop وادر در ٍ 15را تزاتز  اًتْا ًمغِ تا ًظز هَرد لغاع

تاؽذ هثلا در ایي هثال عَل وٌين. )ایي رٍػ داراي همذاري خغا هیهی ٍارد

 تاؽذ(هتز هی 1.55هتز تزاتز  1.5تالىي تزعين ؽذُ تِ خاي 

 ًمغِ ؽزٍع یا اًتخاب

β 

β 

1
.5

 m
 

0
.5

 m
 

tanβ=
𝟎.𝟓

𝟐
 =0.25  => β=14.036 

α=180-(2*β)=180-(2*14.036)=151.928 

2 m 

α 

لغاع ّز ساٍیِ  Angle=
𝜶

𝐍𝐮𝐦𝐛𝐞𝐫
=
𝟏𝟓𝟏.𝟗𝟐𝟖

𝟏𝟓
=10.128 

 Number=15 لغاع تؼذاد

ؽزٍع )عوت ًمغِ را تِ عِ لغوت تمغين وزدُ ٍ در لغوت اٍل ول تالىي -2

 لغوت در Edit>Extrude Points Line هٌَ اس ٍ راعت( را اًتخاب وزدُ

Rotate About Point ّاي دادُ را تا تَخِ تِ اًذاسُ دایزُ هزوش هختصات

 در. ًوائينٍارد هی (2.063,11.5)ؽذُ در پلاى ًغثت تِ هثذا هختصات تزاتز 

 لغاع تؼذاد Number وادر در ٍ 7.552را تزاتز  لغاع ّز ساٍیِ Angle وادر

 ٍارد را 0 ػذد Total Drop وادر در ٍ 10را تزاتز  اًتْا ًمغِ تا ًظز هَرد

 ٍ ًمغِ ؽزٍع )عوت راعت( را اًتخاب وزدُوٌين. تزاي تزعين لغوت دٍم هی

 Rotate About Point لغوت در Edit>Extrude Points Line هٌَ اس

ّاي دادُ ؽذُ در پلاى ًغثت تِ هثذا اًذاسُرا تا تَخِ تِ  دایزُ هزوش هختصات

 لغاع ّز ساٍیِ Angle وادر در. ًوائينٍارد هی (1.937,11.5)هختصات تزاتز 

را  اًتْا ًمغِ تا ًظز هَرد لغاع تؼذاد Number وادر در ٍ -7.552را تزاتز 

وٌين. در لغوت عَم تا هی ٍارد را 0 ػذد Total Drop وادر در ٍ 10تزاتز 

 Draw Line Objects>Draw Lines (plan, elev, 3D)اًتخاب دعتَر 

 وٌين.هغاتك ؽىل تيي دٍ ًمغِ تيز تزعين هی

β 

β 

r
2
=x

2
+y

2
 => 2

2
=x

2
+0.5

2
 => x=1.937 m 

R= 2 m 

0
.5

 m
 

1.937 m 

tanβ=
𝟎.𝟓

𝟏.𝟗𝟑𝟕
 =0.2581  => β=14.4738 

α= 90-β = 90-14.4738 = 75.52 

لغاع ّز ساٍیِ  Angle=
𝜶

𝐍𝐮𝐦𝐛𝐞𝐫
=
𝟕𝟓.𝟓𝟐

𝟏𝟎
=7.552 

وٌينتيي دٍ ًمغِ تيز تزعين هی Number=10 لغاع تؼذاد



     (Reducible Live)                                      سًذُ: سزتار کاّص

تا تَخِ تِ  .ؽَدهی اًدام Options > Preferences > Live Load Reduction لغوت در سًذُ عزتار واّؼ تِ هزتَط تٌظيوات

ّا هاوشیون تذعت ٍ تزاي عتَى User Defined Curves (By Trib Area) گشیٌِ اًتخاب تاآیيي ًاهِ واّؼ عزتار تزاي تيزّا 

 وِ ايًىتِاها تاؽذ. هی User Defined Curves (By Trib Area) ٍ User Defined by Stories Supported ضاتغِآهذُ اس 

 اعت تْتز ضاتغِ دٍ ایي اسٌذ. تٌاتزایي ًيغت تاهيي لاتل ّوشهاى عَر تِ ّاتزاي عتَى ضاتغِ دٍ ّز وِ اعت ایي دارد ٍخَد ایٌدا

را  User Defined Curves (By Trib Area) گشیٌِ ٍ وٌين اًتخاب را ؽَدهی ّاعتَى ؽاهل ّن ٍ تيزّا ؽاهل ّن اٍل حالت

 وليه ًوائيذ. Define دووِ رٍي تز صفحِ پایيي لغوت در عپظ ٍاًتخاب وزدُ 

 ضزایة ایي ؽؾن هثحث در .وٌين هؼزفی افشارًزم تِ را عزتار واّؼ تِ هزتَط ضزایة تایذ ؽَدهی ظاّز وِ خذیذي پٌدزُ در

 تِ تارگيز عغح تز ػلاٍُ ضزایة ایي افشارًزم در اها. ؽَدهی هحاعثِ سًذُ تِ هزدُ تار ًغثت اس هغتملٍ  دارد تارگيز عغح تِ تغتگی

 ؽَد. هؼزفی تایذ سًذُ تِ هزدُ تار هختلف ًغثت دٍ اساي تِ هٌحٌی دٍ حذالل افشار ًزم تِ .دارد تغتگی ّن ُسًذ ٍ هزدُ تار ًغثت

تاؽذ.  یىغاى ّن تا ؽَدهی هؼزفی افشار ًزم تِ وِ هٌحٌی دٍ تایذ تاؽذ سًذُ تِ هزدُ تار ًغثت اس هغتمل عزتار واّؼ آًىِ تزاي

 ػذد یه تزاي را هٌحٌی ایي دٍم تار ٍ (DL/LL Ratio) سًذُ تِ هزدُ تار وَچه ًغثت یه تزاي را هٌحٌی تار یه ایٌىار زايت

 وٌين تَخِ تایذ وٌين.هی هؼزفی را هٌحٌی 02 ًغثت تزاي دٍم تارٍ  2.0 ًغثت تزاي اٍل تار هثال عَر تِ. وٌينهؼزفی هی تشري

 واّؼ همذار ؽؾن هثحث راتغِ اس ًاؽی ػذد ٍ ؽَدهی ضزب سًذُ تار در وِ اعت اػذادي ؽَدهی هؼزفی افشار ًزم تِ وِ اػذادي وِ

 افشارًزم تِ ٍ ؽَد تمغين 022 تز عپظ ٍ ؽذُ واعتِ 022 اس راتغِ ایي اس آهذُ دعت تِ ػذد تایذ وِ اعت درصذ صَرت تِ عزتار

 تزاتز تایذ حذالل ؽًَذهی هؼزفی افشارًزم تِ وِ ضزایثی دیگز تياى تِ یا اعت درصذ 02 عزتار واّؼ همذار حذاوثز .ؽَد هؼزفی

 تاؽذ:خذٍل سیز هی ؽزح تِ ًوایيذ هؼزفی افشارًزم تِ تایذ ًوًَِ عَر تِ وِ اػذاديتاؽٌذ.  2.0

225 196 169 144 121 100 81 64 49 36 25 18 Trib Area 

0.5 0.51 0.53 0.55 0.57 0.6 0.63 0.675 0.73 0.8 0.9 1 Reduction Factor 
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 Add دووِ رٍي تز ٍ وٌينهی اًتخاب 2.0 هثال عَر تِ وَچىی ػذدي را (DL/LL Ratio) همذارتؼذ اس ٍارد وزدى اػذاد، 

Curve هؼزفی افشار ًزم تِ اٍل هٌحٌی هؾاتِ ّن دٍم هٌحٌی تا وٌينهی هؼزفی دٍتارُ را اػذاد ّوييوزدُ  وليه صفحِ تالاي در 

 تِ ٍ وزدُ وليه OK  دووِ تز آى اس تؼذ ٍ .وٌينهی اًتخاب 02 هثال عَر تِ تشرگی ػذدي را (DL/LL Ratio) همذار ٍ ؽَد

  Application to Columns لغوت در وِ عتا ایي وٌين ایداد تایذ وِ دیگزي تغييز تٌْا صفحِ ایي در. گزدینتاسهی لثل صفحِ

 ؽاهل هحَري ًيزٍي تز ػلاٍُ ّاعتَى در عزتار واّؼ تا وٌين اًتخاب را Apply to All Forces/Componentگشیٌِ 

 ًوائين:هی OKآى  اس تؼذ ٍ تؾَد ًيش تزؽی ًيزٍّاي ٍ پيچؾی ٍ خوؾی لٌگزّاي

  

 

 

 

 

 

 

 

 

 



 Design > Concrete Frame Design > Display Design Info                         :ستَى طزاحیًتایح ٍ 

  .ًيغت عَلی آرهاتَرّاي هدذد عزاحی تِ ًياسي ٍ ؽَدهی وٌتزل عتَى همغغ ظزفيت هيلگزدّا اتؼاد ٍ آرایؼ هؼزفی تا ّاعتَى در

 آرهاتَر عَلی:

} = فؾاري ػضَ در گزدهيلِ 2 آساد فاصلِ حذالل گزد تشرگتزلتزاتز لغز هي 0.0  , 40 mm} 

 آرهاتَر ػزضی:

 (:هتز هيلی 102 ٍ عتَى همغغ تشرگتز ضلغ عتَى، آساد ارتفاع ؽؾن یه) همذار تشرگتزیي عتَى پایيي ٍ تالا L0 عَل در*

 وَچىتز ضلغ ًصف خاهَت، لغز تزاتز 01 عَلی، گزد هيلِ وَچىتزیي لغز تزاتز 8ّاي آرهاتَر ػزضی وَچىتزیي همذار )فاصلِ

 تزؽی دیَار وٌار عتَى در. تالاعت همذار ًصف تيز تِ عتَى اتصال تز اس خاهَت اٍليي فاصلِتاؽذ. ( هیهيليوتز 002 عتَى، همغغ

 هتز در ًظز گزفتِ ؽَد.هيلی 8حذالل لغز هيلگزد ػزضی در ًاحيِ ٍیضُ تزاتز  .خَاّذهی آرهاتَر L0 هاًٌذ عتَى ول

 .یاتذ اداهِ ؽالَدُ در هيليوتز 22. عَل در حذالل ػزضی آرهاتَر تایذ ؽالَدُ، تِ عتَى اتصال هحل در*

 ٍ ّاپلِ پاگزد ّايعتَى هاًٌذ) ؽَدهی هتصل تيز آًْا تِ عثمِهياى تزاس در ّن ٍ عثمِ تزاس در ّن وِ ّاییعتَى هَرد در*

 در ٍیضُ گذاري خاهَت تایذ وِ اعت ًحَي تِ عتَى اتؼاد هَارد اغلة در (دٍتلىظ ّايعاختواى تزاس اختلاف هزس در ٍالغ عتًَْاي

 .گيزد اًدام پيَعتِ صَرت تِ عتَى ارتفاع ول

 Design > Concrete Frame Design > Display Design Info                 تیزّا:  طزاحیًتایح ٍ 

 :عَلی آرهاتَر

 گزدهيلِ همذار وِ خا ّز یا ٍ تيز عز 2 در عپظ گشارینهی گزدهيلِ هحاعثاتی یا ٍ آرهاتَر همذار حذالل اًذاسُ تِ تيز ٍعظ در اتتذا

 هيلگزد دٍ حذالل. گشارینهی تمَیتی گزدهيلِ دارین ون وِ اياًذاسُ تِ تَد، گذاؽتين ها وِ همذاري اس تيؾتز Etabsر د هحاعثاتی



 آرهاتَرّاي ؽَد دلت. یاتذ اداهِ عَل عزاعز در همغغ تالاي در ّن ٍ پایيي در ّن تایذ هيليوتز 00 اس تشرگتز یا هغاٍي لغز تا

 .وٌٌذ پيذا اداهِ ؽَدهی لغغ وِ رهاتَريآ لغز تزاتز 00 ٍ همغغ هَثز ارتفاع هؼادل عَلی تِ تایذ تمَیتی

,  } :                           9 هثحث هغاتك وؾؾی آرهاتَر همذار حذالل
 .   √  

  
 ρmin ≥  max { 

 . 

  
 

 max ≤ 0.025ρ                                       :9 هثحث هغاتك وؾؾی آرهاتَر همذار حذاوثز

 تز در تایذ، تزاي ضَاتظ ٍیضُ تزاي سلشلِ، 9هثحث  تٌذّاي عثك سیاد، ٍ هتَعظ پذیزيؽىل تا تتٌی خوؾی ّايلاب تيزّاي در*

 تز در اعت لاسم هٌظَر ایي تِ ؽَد. تاهيي هٌفی خوؾی لٌگز هماٍهت ًصف هيشاى تِ حذالل هثثت خوؾی لٌگز هماٍهت عتَى

 .ًثاؽذ (وؾؾی آرهاتَر)فَلاًی آرهاتَر ًصف اس ووتز (فؾاري آرهاتَر) تحتاًی آرهاتَر همذار ّاعتَى

 هيلی 00 تشرگتز، گزدهيلِ لغز }تزاتز هاوشیون  (آرهاتَر لغز هٌْاي هحَر تِ هحَر فاصلِ) هَاسي گزدهيلِ 0 آساد فاصلِ حذالل *

 تاؽذ.هی {هتز

 .تاؽذ هيليوتز 022 استيؾتز  ًثایذ یىذیگز، اس عَلی هيلگزدّاي هحَر تا هحَر فاصلِ *

 :ػزضی آرهاتَر

 

 

 

 

 

 

 

هماٍهت هؾخصِ فَلادّاي 

 تز حغة هگا پاعىال  ػزضی

ػزض تيز تز حغة 

 هيليوتز

فاصلِ تيي خاهَت ّا 

 تز حغة هيليوتز

d 

2d 2d 

2S S 



 

  .ؽَدهی گزفتِ ًظز در هتزهيلی 02 یا 8 هؼوَلا( ًثاؽذ هتزهيلی 6 اس ووتز ّاخاهَت لغز) وٌينهی اًتخاب را ّاخاهَت لغز اتتذا

 ًوائين.آٍرین ٍ تا همذار آیيي ًاهِ چه هیعپظ تا اعتفادُ اس خزٍخی ایتثظ همذار فاصلِ هيلگزدّاي ػزضی اس ّن تذعت هی

 01 عَلی، آرهاتَر وَچىتزیي لغز تزاتز 8 همغغ، هؤثز ارتفاع چْارم هز: یاسهمادی تيؾتز اسیىذیگز ّاخاهَت فاصلِدر ًاحيِ ٍیضُ *

 فاصلِدر خارج ًاحيِ ٍیضُ لزار دارد،  وِ خوؾی ػضَ اسعَل ّایی لغوت در .ًؾَد اختيار هتزهيلی 22. ٍ ّاَتخاه لغز تزاتز

 .ؽَد اختيار همغغ هؤثز ارتفاع ًصف اس تيؾتز ًثایذ یىذیگز اس ّاخاهَت

 .تاؽذهی تيز ارتفاع تزاتز 2 ّاتيز در ٍیضُ گشاري آرهاتَر تزاي ٍیضُ ًاحيِ*

 .ثاؽذً هتز عاًتی 5 تيؾتز اس عتَى تز اس خاهَت اٍليي فاصلِ*

 )اتصال تیز تِ ستَى(: ّاقاب اتصالات تزاي ٍیضُ ضَاتط

 

 

 

 

 

 

 

 

S 

S1 

h1 h2 

L0 

L0 

L1 

L1 = max { h1 , h2 } 

 

S1< 1.5S 

 



 تذست آهذُ است؟ ETABSسیز کِ اس خزٍخی زاحی هیلگزدّاي طَلی ٍ خاهَت ستَى ٍ تیز ضکل هثال: ط

) (0.059 =عاًتی هتز هزتغ، همذار آرهاتَر ػزضی 31.08َلی تزاتز عاًتی هتز هزتغ، همذار آرهاتَر ع 50*50 همغغ عتَى)
  

 
  ٍ

 درصذ( 1.24درصذ آرهاتَر عَلی تزاتز 

) (0.059 =همذار آرهاتَر ػزضی عاًتی هتز هزتغ، 40*50)همغغ تيز 
  

 
 ٍ همادیز آرهاتَر عَلی عثك ؽىل سیز( 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 همذار آرهاتَر ػزضی تيز

 

 همذار آرهاتَر ػزضی عتَى

عَلی تيز در عِ همذار آرهاتَر 

 ًاحيِ اٍل ٍ ٍعظ ٍ اًتْاي تيز

 

 همذار آرهاتَر عَلی عتَى تزاتز

 هزتغ هتز عاًتی 31.08

درصذ آرهاتَر عَلی تيز در اتتذا، ٍعظ ٍ 

درصذ  1.2درصذ ٍعظ،  0.6اًتْاي تيز )

 درصذ در اًتْا( 1.24اتتذا ٍ 

 

 

 1.24 تزاتز عتَى عَلی آرهاتَر درصذ

 درصذ



 حل(

fy=400 Mpa or N/mm(  :      عتَى الف( عزاحی
2   ٍfyv= 300 Mpa or N/mm

2   
( 

 ok                  0 ≤ 0.01 ≤ .تزرعی درصذ فَلاد عتَى:                                     گام اٍل:

As=31.08 cm           عزاحی هيلگزدّاي عتَى: گام دٍم: 
2
 => As=n𝜋d

2
/4 =>    if  => d=16mm ==>  n=16 

     ====>  use 16Ø16 

 وٌتزل فاصلِ آساد ٍ هحَر تِ هحَر هيلگزد عَلی: گام عَم:

 

   

 

 

 

 عزاحی هيلگزد ػزضی: گام چْارم:

L0 = max{
 

 
*2900=490, 500, 450 } = 500 mm =>  use 550mm 

S0= min {8*16=128 , 24*10=240 , 
   

 
 =250 , 250} = 128 mm 

  

 
 = 0.059 > 

  

 
 )min =0.35*

  

   
 = 0.058  => OK  S≤ 

   .       

   .   
 = 406 mm 

 use Ø10 @ 12.5  n=5 

 اتصال هحل دردّين ٍ عاًتی هتز افشایؼ هی 00ّا را تِ خاهَتؽَد، فاصلِ گذاري ٍیضُ هیدر ًَاحی وِ خارج ًاحيِ ٍیضُ خاهَت

 عتَى تز اس خاهَت اٍليي فاصلٍِ ّوچٌيي  یاتذ اداهِ ؽالَدُ در هيليوتز 22. عَل در حذالل ػزضی آرهاتَر تایذ ؽالَدُ، تِ عتَى

 گيزین:در ًظز هی هتز عاًتی 0 را تزاتز

 use Ø10 @ 15  n=13 

 use Ø10 @ 12.5  n=3 

 

 

ٍ همذار پَؽؼ تتي تا تَخِ تِ ؽزایظ هحيغی هتَعظ تزاتز  10Øّاي تا فزض اعتفادُ اس خاهَت

 هيلگزدّا تزاتز اعت تا:هتز، فاصلِ هزوش تِ هزوش ٍ فاصلِ آساد هيلی 45

 mm < 200 mm => ok 93.5 =4/[(8+10+45)*2-500] = فاصلِ هزوش تِ هزوش

 mm > max {40 mm , 24 mm} => ok 77.5 =[16 - 93.5]= فاصلِ آساد هيلگزدّا

ػذد خاهَت   3

 هتزهيلی 10لغز 

 ػزضی آرهاتَر تایذ ؽالَدُ، تِ عتَى اتصال هحل در

 .یاتذ اداهِ ؽالَدُ در هيليوتز 22. عَل در حذالل
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fy=400 Mpa or N/mm(  تيز:       ( عزاحیب
2   ٍfyv= 300 Mpa or N/mm

2 
  ٍfc= 25Mpa ) 

 تزرعی درصذ فَلاد عَلی تيز: گام اٍل: 

}max : اتتذا
 . 

   
  .   , 

 .     

   
  .   }=0.3 ≤  0.65 ≤  2.5   ==> ok 

}max : ٍعظ
 . 

   
  .   , 

 .     

   
  .   }=0.3 ≤  0.31 ≤  2.5  ==> ok 

}max : اًتْا
 . 

   
  .   , 

 .     

   
  .   }=0.3 ≤  0.60 ≤  2.5  ==> ok 

  هيلگزدّاي عزاعزي عَلی تيز:عزاحی گام دٍم: 

 00 اس تشرگتز یا هغاٍي لغز تا  هيلگزد دٍ حذالل. گشارینهی گزدهيلِ هحاعثاتی یا ٍ آرهاتَر همذار حذالل اًذاسُ تِ تيز ٍعظ در اتتذا

 .یاتذ اداهِ عَل عزاعز در همغغ تالاي در ّن ٍ پایيي در ّن تایذ هتزهيلی

As=6.152 cm
2
 => As=n𝜋d

2
/4 =>    if  => d=16mm ==>  n=3 

  عَلی تيز: تمَیتیعزاحی هيلگزدّاي گام عَم: 

 دارین ون وِ اياًذاسُ تِ تَد، گذاؽتين ها وِ همذاري اس تيؾتز Etabsر د هحاعثاتی گزدهيلِ همذار وِ خا ّز یا ٍ تيز عز 2 در

 ؽَدهی لغغ وِ رهاتَريآ لغز تزاتز 00 ٍ همغغ هَثز ارتفاع هؼادل عَلی تِ تایذ تمَیتی آرهاتَرّاي .گشارینهی تمَیتی گزدهيلِ

       :وٌٌذ پيذا اداهِ
 

 
 * (360-50) = 103.3 + max {40 , 12*1.6=19.2} = 140   عَل آرهاتَر تمَیتی =   

گاُ اتتذاي تيزدر تىيِ  As=12.916 - 6.152= 6.764 cm
2
 => As=n𝜋d

2
/4 =>    if  => d=16mm ==>  n=4 

گاُ اًتْاي تيزتىيِدر  As=13.439 - 6.152= 7.287 cm
2
 => As=n𝜋d

2
/4 =>    if  => d=16mm ==>  n=4 

 وٌتزل فاصلِ آساد ٍ هحَر تِ هحَر هيلگزد عَلی:گام چْارم: 

 

 

 

 

 

  

 

ٍ همذار پَؽؼ تتي تا تَخِ تِ ؽزایظ هحيغی هتَعظ تزاتز  10Øّاي تا فزض اعتفادُ اس خاهَت

 هتز، فاصلِ هزوش تِ هزوش ٍ فاصلِ آساد هيلگزدّا تزاتز اعت تا:هيلی 45

تِ هزوش فاصلِ هزوش  = [500-2*(45+10+8)]/6= 62.3 mm < 200 mm => ok 

 mm > max {25 mm , 16 mm} => ok 46.3 =[16 - 62.3]= فاصلِ آساد هيلگزدّا



 عزاحی هيلگزد ػزضی: گام پٌدن:

L0 = 2*d = 2*400 = 800 mm 

S0= min {8*16=128 , 24*10=240 , 
   

 
 =100 , 300} = 100 mm 

S1= d/2 = 400/2 = 200 mm 

 

  

 
 = 0.059 > 

  

 
 )min =0.35*

  

   
 = 0.058  => OK  S≤ 

   .       

   .   
 = 271 mm 

 use Ø10 @ 100  n=9 

 فاصلِدّين ٍ ّوچٌيي عاًتی هتز افشایؼ هی 02ّا را تِ ؽَد، فاصلِ خاهَتٍیضُ هیگذاري در ًَاحی وِ خارج ًاحيِ ٍیضُ خاهَت

 گيزین:در ًظز هی هتز عاًتی 0 را تزاتز عتَى تز اس خاهَت اٍليي

 use Ø10 @ 200  n=6 

 

 

 

 

 

ػذد خاهَت   2

 هتزهيلی 10لغز 

SEC M-M SEC N-N 

N 

N 


